HP G72 Notebook PC

Maintenance and Service Guide

SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.
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Revision

Publication date

Description

A

October 2010

Added newly supported hard drives to spare parts listings in the
following locations: Computer major components on page 18, Mass
storage devices on page 27, Sequential part number listing

on page 30, Hard drive on page 43.

Added newly supported memory modules to spare parts listings in the

following locations: Computer major components on page 18,
Sequential part number listing on page 30, Memory module

on page 51.

Added newly supported processors to spare parts listings in the
following locations: Computer major components on page 18,
Sequential part number listing on page 30, Processor on page 83.

Added newly supported system boards to spare parts listings in the
following locations: Computer major components on page 18,
Sequential part number listing on page 30, System board

on page 75.

Added newly supported back covers to spare parts listings in the
following locations: Computer major components on page 18,
Sequential part number listing on page 30, Display assembly
components on page 24, Display assembly on page 69.

Added newly supported display assemblies to spare parts listings in
the following locations: Computer major components on page 18,
Sequential part number listing on page 30, Display assembly
components on page 24, Display assembly on page 69.

Added newly supported optical drives to spare parts listings in the
following locations: Computer major components on page 18, Mass
storage devices on page 27, Sequential part number listing

on page 30, Optical drive on page 46.

December 2010

Added newly supported processors to spare parts listings in the
following locations: Computer major components on page 18,
Sequential part number listing on page 30, Processor on page 83.

Added newly supported system boards to spare parts listings in the
following locations: Computer major components on page 18,
Sequential part number listing on page 30, System board

on page 75.
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Safety warning notice

A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category Description HP G72 HP G72
Discrete UMA

Product Name HP G72 Notebook PC v v
Processors Intel® Arrandale™ i5-540M Processor (2.53 GHz, 3 MB v v

total L3 cache, 1066 MHz)—Dual core 35 W

Intel Arrandale i5-520M Processor (2.4 GHz, 3 MB total v v

L3 cache, 1066 MHz)—Dual Core 35 W

Intel Arrandale i5-480M Processor (2.66 GHz 3 MB L3 v v

cache)—Dual core 35 W

Intel Arrandale i3-390M Processor (2.66 GHz 3MB L3 v v

cache)—Dual core

Intel Arrandale i5-450M Processor (2.4 GHz, 3 MB total v v

L3 cache, 1066 MHz)—Dual Core 35 W

Intel Arrandale i5-430 Processor (2.26 GHz, 3 MB total v v

L3 cache, 1066 MHz)—Dual Core 35 W

Intel Arrandale i3—370 Processor (2.4 GHz, 3 MB L3 v v

cache, 1066 MHz)—Dual Core 35 W

Intel Arrandale i3—350 Processor (2.26 GHz, 3 MB L3 v v

cache, 1066 MHz)—Dual Core 35 W

Pentium® Arrandale P6000 Processor (1.86 GHz, 3 MB, v v

L3 cache 100 MHz)

Pentium Arrandale P6300 (2.26 GHz 3 MB L3 cache) v v
Chipset Intel® HM55 Express Chipset v v
Graphics ATI Mobility Radeon™ HD5470 with 512 MB dedicated v v

video memory

ATI Mobility Radeon HD5470 with 1 G dedicated video v y

memory

UMA (integrated) with shared video memory v

Robson XT (ATl Mobility Radeon™ HD6370) with 512MB v

of dedicated video memory (64Mx16 DDR3 800MHz x 4

PCs) (for model 1.2 only)

ATi Robson XT (ATl Mobility Radeon™ HD6370) with v

1GB of dedicated video memory (128Mx16 DDR3
800MHz x 4 PCs) (for model 1.2 only)
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Category

Description

HP G72

HP G72

Discrete

UMA

Switchable Discrete Graphics

e  ATi Robson XT (ATI Mobility Radeon™ HD6370)
with 512MB of dedicated memory (64Mx16 DDR3
800 MHz x 4 PCs)

e  ATi Robson XT (ATl Mobility Radeon™ HD6370)
with 1GB of dedicated memory (128Mx16 DDR3
800 MHz x 4 PCs)

\/

Support for BD or HD-DVD playback with HD decoder
and DX10 support

Panel

43.9-cm (17.3-in) HD LED BrightView (1600 x 900)

16:9 wide aspect ratio

Memory

2 customer-accessible/upgradable SODIMM slots

Supports dual-channel memory DDR3, 1333 MHz

Supports up to 8 GB of system memory

2 | 2| 2| 2| =

2 | 2| 2| <2 | =

Supports the following configurations:

e 4096 MB (2048 MB x 2)

o 3072 MB (1024 MB x 1 + 2048 MB x 1)

e 2048 MB (2048 MB x 1)

e 2048 MB (1024 MB x 2)

e 1024 MB (1024 MB x 1)

Hard drives

Supports 9.5-mm, 6.35-cm (2.5-in) SATA hard drive

Customer accessible

< | 2| 2| 2| 2| 2| =

< | 2| 2| 2| 2| 2| =

Supports the following drives:

e 750 GB, 5400 rpm

e 640 GB, 5400 rpm

e 500 GB, 7200 rpm

e 320 GB, 5400 rpm

e 320 GB, 7200 rpm

e 250 GB, 7200 rpm

° 160 GB, 7200 rpm

Optical drives

12.7-mm (0.50-in) fixed SATA tray load

DVD+RW and CD-RW SuperMulti Double-Layer Combo
Drive with LightScribe

2 | 2| 2| 2| 2| 2| 2| 2| <

2 | 2| 2| 2| 2| 2| 2| 2| <

Blu-ray ROM with LightScribe DVD+R/RW SuperMulti
Double-Layer Drive

Webcam (select models only)

VGA camera, fixed angle with activity light and single
analog microphone

Chapter 1 Product description
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Category Description HP G72 HP G72
Discrete UMA
Microphone Integrated single analog microphone (for models with no v v
webcam)
Audio High-definition audio supports Microsoft® premium v v
requirements with Presario/HP Altec Lansing speakers
Modem (select models only) 56K V.92 data/fax MDC modem (computer models not v v
equipped with a modem have a cover over the RJ-11
jack opening)
Supports all worldwide certification requirements v v
Ethernet Integrated 10/100 network interface card (NIC) v v
Wireless Integrated wireless local area network (WLAN)
options by way of wireless module:
2 wireless antennas built into display assembly v v
Support for no-WLAN option v v
Support for the following WLAN formats:
Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter V v
Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter v v
Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 \ v
Bluetooth 2.1+EDR Combo adapter (BT3.0+HS ready)
Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth \ \
2.1+EDR Combo Adapter (BT3.0+HS ready)
External media card (select Digital Media Slot supporting SD, MMC, MS, MSPro, xD v v
models only ) cards. Supports mini versions of SD, MMC, MS Duo with
adapter, not included
Ports Audio-in (stereo microphone) v v
Audio-out (stereo headphone) \ v
High-Definition Multimedia Interface (HDMI) version 1.3 v v
supporting 1080p with High-bandwidth Digital Content
Protection (HDCP) key (select models only)
Hot plug/unplug with auto-detect v v
RJ-11 (modem, select models only) v v
RJ-45 (Ethernet) v v
USB (3; one is an eSATA/USB port) v v
VGA (Dsub 15-pin) supporting 1600 x 1200 external v v
resolution at 75 Hz
Multi-pin AC power v v
Keyboard/pointing devices Full-size keyboard with numeric keypad, 43.9-cm (17.3- v v
in)
TouchPad with 2 buttons and 2-way scroll (taps enabled v v

as default)
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Category Description HP G72 HP G72
Discrete UMA

Power requirements 6-cell, 2.20 Ah, 47 Wh battery \ \/
6-cell, 2.55 Ah, 55 Wh battery \ \
6-cell, 2.8 Ah, 62 Wh battery v v
65-W AC adapter with localized cable plug support \
90-W AC adapter with localized cable plug support \/

Security Kensington Security Lock \/ \/

Operating system Preinstalled:
Windows® 7 Home Premium (32 & 64 bit) N N
Windows 7 Home Basic (32 & 64 bit) N N
Free DOS \/ V

Serviceability End-user replaceable parts:
AC adapter N N
Battery (system) \/ \/
Hard drive \/ \/
Memory module \/ J
Optical drive \/ J
Mini-card devices J J

Chapter 1 Product description ENWW



2 External component identification

Identifying the hardware

Components included with the computer might vary by region and model. The illustrations in this
chapter identify the standard features on most computer models.

To see a list of hardware installed in the computer:

1. Select Start > My Computer.

2. Inthe left pane of the System Tasks window, select View system information.
3. Select Hardware tab > Device Manager.

Add hardware or modify computer configurations using Device Manager.

ENWW Identifying the hardware 5



Top components
TouchPad

]

Component Description

(1) TouchPad light Off—Touchpad is on.

Amber—Touchpad is off.

(2) TouchPad zone Moves the pointer and selects or activates items on the
screen.
(3) Left TouchPad button Press the left side of the TouchPad button to execute

functions like the left button on an external mouse.

4) Right TouchPad button Press the right side of the TouchPad button to execute
functions like the right button on an external mouse.

*This table describes factory settings.

To view or change the pointing device preferences:
1. Select Start > Devices and Printers.
2. Right-click the device representing the computer.

3. Select Mouse settings.

6 Chapter 2 External component identification ENWW



Lights

ENWW

Component

Description

(1)

TouchPad light

Off—TouchPad is enabled.

Amber—TouchPad is disabled.

)

Caps lock light

On—Caps lock is on

®)

Power light

On—The computer is on.
Flashing—The computer is in Sleep.

Off—The computer is off or in Hibernation.

(4)

Wireless light

White—An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

Amber—No wireless devices are detected.

®)

num Ik light

On—The numeric function of the keypad is enabled.

Off—The navigation function of the keypad is
enabled.

Top components
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Button and speakers

O

Component Description

(1) Power button e  When the computer is off, press the button to turn on
the computer.

e  When the computer is on, press the button to initiate
Sleep.

e  When the computer is in Sleep, press the button to exit
Sleep.

e  When the computer is in Hibernation, press the button
to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least five seconds to turn off the
computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power Options.

(2) Speakers grill Two integrated speakers produce sound.

*This table describes factory settings. For information about changing factory settings, see the user guides located in Help
and Support.

8 Chapter 2 External component identification ENWW
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Component

Description

M

esc key

Displays system information when pressed in combination
with the fn key.

)

fn key

Displays system information when pressed in conjunction
with the esc key.

@)

Windows logo key

Displays the Windows Start menu.

4)

Windows applications key

Displays a shortcut menu for items where the cursor is
positioned

®)

Integrated numeric keypad keys

Used like the keys on an external numeric keypad.

(6)

Action keys

Executes frequently-used system actions.

Top components
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Display

Component Description

(1) Internal microphone Records sound.

(2) Integrated webcam (select models only) Records audio and video and captures still photographs.
(3) Webcam light (select models only) On—The webcam is in use.

10 Chapter 2 External component identification ENWW



Right-side components

ENWW

Component

Description

M

Optical drive

Reads and writes to optical discs.

@)

Optical drive light on release button

Flashing—The optical drive light is being accessed.

@)

USB port

Connects an optional USB device.

(4)

RJ-11 (modem) jack (select models only)

Connects a modem cable.

®)

AC adapter light

° Flashing white—The computer is in Sleep.

e  On white—The computer is connected to external power.

e  Flashing amber—The computer is charged.

e  Off—The computer is not connected to external power.

(6)

Power connector

Connects an AC adapter.

7

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent,
but it might not prevent the computer from being mishandled
or stolen.

Right-side components
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Left-side components

GHEO0 &

Component

Description

(1) External monitor port

Connects an external VGA monitor or projector.

(2) Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3) HDMI port (select models only)

Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or audio
component.

NOTE: Depending on the computer model, the computer
might include an HDMI port or a USB port at this location.

(4) Network connection light

White—The computer is connected to the network.

(5) RJ-45 (network) jack

Connects a network cable.

(6) Network activity light

Amber—Data is being transmitted over the network.

(7) USB ports (2)

Connects an optional USB devices.

(8) Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(9) Audio-out (headphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio.

(10) Digital Media Slot (select models only)

Supports the following optional digital card formats:
e  Memory Stick (MS)

e  Memory Stick Pro (MSP)

e  MultiMediaCard (MMC)

e  Secure Digital (SD) Memory Card

e  xD-Picture Card (XD)

(11) Drive light

On—The hard drive is in use.

12 Chapter 2 External component identification
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Bottom components

Component Description
1) Battery bay Holds the battery.
(2) Vents (5) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine

operation.
3) Battery release latch Releases the battery from the battery bay.
(4) Hard drive bay Holds the hard drive.
(5) Memory module compartment Contains two memory module slots and, on select

models, the wireless LAN (WLAN) device.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.

Wireless antennas

At least two antennas send and receive signals from one or more wireless devices. These antennas
are not visible from the outside of the computer.

ENWW Bottom components 13



B NOTE: For optimal transmission, keep the areas immediately around the antennas free from
obstructions.

To review the wireless regulatory notices, see to the section of the Regulatory, Safety and
Environmental Notices that applies to your country or region. These notices are located in Help and

Support.
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Additional hardware components

ENWW

Component

Description

(1) Power cord*

Connects an AC adapter to an AC outlet.

(2) AC adapter

Converts AC power to DC power.

3) Battery*

Powers the computer when the computer is not plugged into
external power.

*Power cords vary in appearance by country or region.

Additional hardware components
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3

lllustrated parts catalog

Serial number location

When ordering parts or requesting information, provide the computer serial number and model
number located in the battery bay of the computer.

ENWW

x IIILINAN
o (LT ETUEERE T

I

Component

Description

M

Product name

The name affixed to the front of the computer.

)

Serial number (s/n)

An alphanumeric identifier that is unique to each product.

@)

Part number/Product number (p/n)

This number provides specific information about the product’s
hardware components. The part number helps a service technician
to determine what components and parts are needed.

(4)

Warranty period

The duration of the warranty period for the computer.

®)

Model description

An alphanumeric identifier used to locate documents, drivers, and
support for the computer.

Serial number location 17
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Item

Description

Spare part number

M

43.9-cm (17.3-in) High Definition (HD), light-emitting diode (LED) display assembly

for use in:
NOTE: For more display assembly internal component spare part information, see
Display assembly components on page 24.
e  Biscotti computer models 612094-001
e  Matte black computer models 612095-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 620538-001
(2) Keyboard (includes keyboard cable) for use in:
e  Adriatics (for models 1.0 and 1.1 only) 615850-BA1
e  Belgium (for models 1.0 and 1.1 only) 615850-A41
e  Czech Republic (for models 1.0 and 1.1 only) 615850-221
e  France (for models 1.0 and 1.1 only) 615850-051
e  French Canada (for model 1.1 only) 615850-121
e  Germany (for models 1.0 and 1.1 only) 615850-041
e  Greece (for models 1.0 and 1.1 only) 615850-DJ1
e  Hungry (for models 1.0 and 1.1 only) 615850-211
e for International use (for models 1.0 and 1.1 only) 615850-B31
e Israel (for models 1.0 and 1.1 only) 615850-BB1
e ltaly (for models 1.0 and 1.1 only) 615850-061
e  Norway (for models 1.0 and 1.1 only) 615850-DH1
e  Portugal (for models 1.0 and 1.1 only) 615850-131
e  Russia (for models 1.0 and 1.1 only) 615850-251
e  Saudi Arabia (for models 1.0 and 1.1 only) 615850-171
e  Spain (for models 1.0 and 1.1 only) 615850-071
e  Switzerland (for models 1.0 and 1.1 only) 615850-BG1
e  Turkey (for models 1.0 and 1.1 only) 615850-141
e  United Kingdom (for models 1.0 and 1.1 only) 615850-031
e  United States (for models 1.1 and 1.2 only) 615850-001
3) Power button board 616495-001
(4) Speaker assembly (includes cable) 616498-001
(5) Top cover (includes TouchPad board) for use in:
e  Biscotti computer models 616490-001
e  Matte black computer models 616492-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 620542-001
(6) Touchpad button board (includes bracket and cable) 616493-001
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Description

Spare part number

Fan/heat sink assembly (includes replacement thermal material) for use with:

e  UMA systems 606013-001
e Discrete systems 606014-001
Thermal Pad (not shown) 634363-001
(8) Processor (includes replacement thermal material)
e Intel Arrandale i7-620M Processor (2.66 GHz, 4 MB total L3 cache, 1066 MHz)— 587259-001
Dual Core 35 W

e Intel Arrandale i5-520M Processor (2.4 GHz, 3 MB total L3 cache, 1066 MHz)— 594187-001
Dual Core 35 W (for models 1.0 and 1.1 only)

e Intel Arrandale i5-540M Processor (2.53 GHz, 3 MB total L3 cache, 1066 MHz)— 594188-001
Dual core 35 W (for models 1.0 and 1.1 only)

e Intel Arrandale i3—350 Processor (2.26 GHz, 3 MB L3 cache, 1066 MHz)—Dual 597623-001
Core 35 W (for models 1.0 and 1.1 only)

e Intel Arrandale i5-430 Processor (2.26 GHz, 3 MB total L3 cache, 1066 MHz)—Dual 597624-001
Core 35 W (for models 1.0 and 1.1 only)

e Intel Arrandale i3—370 Processor (2.4 GHz, 3 MB L3 cache, 1066 MHz)—Dual Core = 613584-001

35W

e Intel Arrandale i5-450M Processor (2.4 GHz, 3 MB total L3 cache, 1066 MHz)— 613585-001

Dual Core 35 W (for models 1.0 and 1.1 only)

e  Pentium Arrandale P6000 Processor (1.86 GHz, 3 MB, L3 cache 100 MHz) (for 613586-001

models 1.0 and 1.1 only)

e  Pentium Arrandale P6100 Processor (2.0 GHz, 3 MB, L3 cache 100 MHz) (for 613587-001

models 1.1 and 1.2 only)
e Intel Arrandale i3—380M Processor (2.53 GHz, 3 MB total L3 cache, 1066 MHz)— 625823-001
Dual Core 35 W (for models 1.1 and 1.2 only)

° Intel Arrandale i5-560M Processor (2.66-3.2 GHz, 3 MB total L3 cache, 1066 MHz) 625824-001
—Dual Core 35 W (for models 1.1 and 1.2 only)

e Intel Arrandale i5-580M Processor (2.66—3.33 GHz, 3 MB total L3 cache, 1066 625825-001
MHz)—Dual Core 35 W (for model 1.1 only)

e Intel Pentium P6200 Processor (2.13 GHz, 3 MB, L3 cache 100 MHz) (for models 625831-001
1.1 and 1.2 only)

e Intel Core i5-460M Processor (2.53 GHz, 3 MB total L3 cache, 1066 MHz)—Dual 626039-001
Core 35 W (for models 1.1 and 1.2 only)

e Intel Arrandale i3-390M Processor (2.66 GHz 3MB L3 cache)—Dual core (for model 634692-001
1.2 only)

e Intel Arrandale i5-480M Processor (2.66 GHz 3 MB L3 cache)—Dual core 35 W (for  634693-001

model 1.2 only)

e  Pentium Arrandale P6300 (2.26 GHz 3 MB L3 cache) (for model 1.2 only) 635500-001
(9) RTC battery (includes mounting adhesive) 616501-001
(10) Memory module (1066 MHz, DDR3)

e 1GB 598859-001
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Item Description Spare part number
e 2GB 598856-001
e 4 GB (for models 1.1 and 1.2 only) 599092-001

(1)

Wireless (WLAN) module

Atheros AR9285 802.11b/g/n 1x1 WiFi Adapter for use in Afghanistan, Albania, 518436-002
Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Australia,
Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Belize, Benin, Bhutan,
Bosnia and Herzegovina, Botswana, Brazil, Brunei, Bulgaria, Burkina Faso, Burundi,
Cambodia, Cameroon, Cape Verde, Central African Republic, Chad, Chile, China,
Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, Czech Republic, Zaire,
Denmark, Djibouti, Dominica, Dominican Republic, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guatemala, Guinea,
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India,
Indonesia, Ireland, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya,
Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Martinique,
Nether Antilles, French Guiana, Aruba, British Virgin Islands, Bermuda, Syria,
Guadeloupe, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, Maldives, Mali, Malta, Marshall Islands, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, Peru, Philippines,
Poland, Portugal, Republic of Moldova, Romania, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and Montenegro,
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Timor (East), Togo, Tonga, Trinidad and
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, United Arab Emirates,
United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zambia, and Zimbabwe

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 WLAN module for use in 593530-001
Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cameroon, Canada, Cape Verde, the Cayman Islands, the Central
African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic,
East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guam, Guinea,
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India,
Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's
Republic of China, Peru, the Philippines, Poland, Portugal, Puerto Rico, the
Republic of Moldova, Romania, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, the United Arab Emirates, the United Kingdom, Uruguay, the U.S.
Virgin Islands, the United States, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe
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Item Description Spare part number
e  Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter (for models 1.0 and 1.1 only) 593533-001
e  Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter 593836-001
e  Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter 600370-001
(BT3.0+HS ready) (for models 1.1 and 1.2 only)
e  Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter =~ 602992-001
(BT3.0+HS ready) (for models 1.1 and 1.2 only)
(12) Modem module (select models only) (for model 1.0 only) 510100-001
(13) System board (includes replacement thermal material) for use in:
e HD 5430/1 G discrete system board with card reader 1.1 (for model 1.1 only) 615847-001
e HD 5430/512 MB discrete system board with card reader 1.1 (for model 1.1 only) 615848-001
e HD 5430/512 MB discrete system board with card reader (for model 1.0 only) 629120-001
e  HD 5430/1 G discrete system board with card reader (for model 1.0 only) 629121-001
e  HD UMA system board with card reader (for model 1.2 only) 629122-001
e HD 1G discrete system board with card reader (for model 1.2 only) 630948-001
e  HD 512 discrete system board with card reader (for model 1.2 only) 630949-001
(14) Hard drive
e 750 GB, 5400 rpm (for model 1.1 only) 603787-001
e 640 GB, 5400 rpm 603785-001
e 320 GB, 5400 rpm (for models 1.1 and 1.2 only) 622643-001
e 320 GB, 7200 rpm 615084-001
e 250 GB, 7200 rpm 615083-001
e 160 GB, 7200 rpm (for models 1.0 and 1.1 only 615082-001
e  Hard Drive Hardware Kit (not illustrated, includes bracket and screws) 615086-001
(15) Power connector (includes cable) 616496-001
(16) USB board 616494-001
17) RJ-11 connector included in Cable Kit 616502-001
(18) Optical drive bracket included with optical drive
(19) Battery
e  6-cell Li-lon, 2.20 Ah, 47 Wh 593553-001
e  6-cell Li-lon, 2.55 Ah, 55 Wh 593554-001
(20) Optical drive (includes optical drive bezel and bracket)
DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use
with:
e  Biscotti computer models 614549-001
e  Matte black computer models 616482-001
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Item Description Spare part number
e  Charcoal computer models (for models 1.1 and 1.2 only) 620541-001
Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with:
e  Biscotti computer models 614548-001
e  Matte black computer models 616480-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 620540-001
(21) Optical drive cable included in Cable Kit 616502-001
Bluetooth module (not shown) (for model 1.0 only) 537921-001
Bluetooth module cable (not shown) (for model 1.0 only) 605904-001
(22) Base enclosure for use with:
e  Biscotti computer models with HDMI card reader, without modem 616485-001
e  Matte black models with HDMI card reader, without modem 616489-001
e  Charcoal models with HDMI card reader, without modem (for models 1.1 and 1.2 616488-001
only)
Rubber Kit (not illustrated, includes four rubber feet) 616499-001
Plastics Kit 616497-001
(23) e  Hard drive cover
(24) e  Memory module cover
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assembly components

o_

Item Description Spare part number
(1) Display bezel: 612102-001
(2) Webcam module 612109-001
(3) 43.9-cm (17.3-in) high definition, Brightview, display panel (includes display panel 612097-001
cable)
(4) Display bracket (with hinges) 612104-001
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(5) Display hinge covers 612105-001
(6) Wireless antenna (includes wireless antenna transceivers and cable) 612108-001
(7) Microphone (includes cable) 612110-001
(8) Display back cover (includes logo) for use with:
e  Biscotti computer models 612098-001
e  Matte black computer models 612099-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 620539-001
LCD cable (not illustrated; includes webcam module cable) 612103-001
Display screw kit (not illustrated) 612107-001

Display rubber display kit (not illustrated, includes display bezel rubber screw covers) 612106-001
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Plastics Kit
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F

Item  Description Spare part number
Plastics kit 616497-001

(1) Hard drive bay cover (includes captive screws)

(2) Wireless/memory module mini-card compartment cover (includes captive screw)
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Mass storage devices

Item Description Spare part number
(1) Optical drive (12.7 mm, SATA, fixed, includes bezel and bracket)

DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use

with:

e  Biscotti computer models 614549-001

e  Matte black computer models 616482-001

e  Charcoal computer models (for models 1.1 and 1.2 only) 620541-001

Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with:

e  Biscotti computer models 614548-001
e  Matte black computer models 616480-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 620540-001
(2) Hard drive
e 750 GB, 5400 rpm (for model 1.1 only) 603787-001
e 640 GB, 5400 rpm 603785-001
e 500 GB, 7200 rpm 615085-001
e 320 GB, 5400 rpm (for models 1.1 and 1.2 only) 622643-001
e 320 GB, 7200 rpm 615084-001
e 250 GB, 7200 rpm 615083-001

ENWW Mass storage devices 27



Item Description Spare part number

e 160 GB, 7200 rpm (for models 1.0 and 1.1 only) 615082-001

Hard drive hardware kit (not illustrated, includes bracket and screws) 615086-001
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Description

Spare part number

AC adapters

65-W AC adapter

609939-001

90-W AC adapter

609940-001

Power cord, AC, 3 wire, black, 1.83-m (for use with both HP G62 and Presario CQ 62 computer models) for use in:

e  Denmark (for models 1.0 and 1.1 only) 490371-081
e  Europe (for models 1.0 and 1.1 only) 490371-021
e |srael (for models 1.0 and 1.1 only) 490371-BB1
e |taly (for models 1.0 and 1.1 only) 490371-061
e  North America (for models 1.0 and 1.1 only) 430971-001
e  Switzerland (for models 1.0 and 1.1 only) 490371-111
e the United Kingdom and Singapore (for models 1.0 and 1.1 only) 490371-031
Cable Kit 616502-001
e  Hard drive connector cable

e  Optical drive connector cable

e  Power button cable

e RJ-11 cable

e  TouchPad cable

e USB cable

Screw kit 616500-001

Phillips M2.0x3.0 screw

Phillips M2.5x3.0 screw

Phillips M2.5x4.0 screw

Phillips M2.5x5.0 screw

Phillips M2.5x6.5 screw

Miscellaneous parts
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Spare part number Description

490371-001 Power cord for use in North America (for models 1.0 and 1.1 only)

490371-021 Power cord for use in Europe (for models 1.0 and 1.1 only)

490371-031 Power cord for use in the United Kingdom and Singapore (for models 1.0 and 1.1 only)
490371-061 Power cord for use in Italy (for models 1.0 and 1.1 only)

490371-081 Power cord for use in Denmark (for models 1.0 and 1.1 only)

490371-111 Power cord for use in Switzerland (for models 1.0 and 1.1 only)

490371-BB1 Power cord for use in Israel (for models 1.0 and 1.1 only)

510100-001 56K V.92 data/fax modem (select models only) (for model 1.0 only)

518436-002 Atheros AR9285 802.11b/g/n 1x1 for use in Afghanistan, Albania, Algeria, Andorra, Angola,

Antigua and Barbuda, Argentina, Armenia, Australia, Austria, Azerbaijan, Bahamas, Bahrain,
Barbados, Belgium, Belize, Benin, Bhutan, Bosnia and Herzegovina, Botswana, Brazil, Brunei,
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, Central African Republic,
Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, Czech Republic,
Zaire, Denmark, Djibouti, Dominica, Dominican Republic, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guatemala, Guinea, Guinea-Bissau, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Italy, Ivory Coast,
Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Martinique, Nether Antilles, French Guiana, Aruba, British Virgin
Islands, Bermuda, Syria, Guadeloupe, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall Islands, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama,
Papua New Guinea, Paraguay, Peru, Philippines, Poland, Portugal, Republic of Moldova,
Romania, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Thailand, Timor (East), Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, United Arab Emirates, United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zambia, and Zimbabwe

537921-001 Bluetooth module (for model 1.0 only)

587259-001 Intel Core i7-620M Processor (4M cache, 2.66 GHz, SC turbo up to 3.33 GHz)
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593530-001 Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 WLAN module for use in Afghanistan, Albania,
Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin,
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands,
Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Canada, Cape Verde, the Cayman Islands,
the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guam, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua
New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, Puerto Rico, the Republic of Moldova, Romania, Rwanda, Samoa, San Marino, Sao
Tome and Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, the United Arab
Emirates, the United Kingdom, Uruguay, the U.S. Virgin Islands, the United States, Uzbekistan,
Vanuatu, Venezuela, Vietham, Yemen, Zaire, Zambia, and Zimbabwe

593533-001 Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter (for models 1.0 and 1.1 only)

593553-001 Battery, 6-cell, 2.20 Ah, 47 Wh

593554-001 Battery, 6-cell, 2.55 Ah, 55 Wh

593836-001 Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter

594187-001 Intel Arrandale i5-520M Processor (2.4 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 35
W (for models 1.0 and 1.1 only)

594188-001 Intel Arrandale i5-540M Processor (2.53 GHz, 3 MB total L3 cache, 1066 MHz)—Dual core 35
W (for models 1.0 and 1.1 only)

597623-001 Intel Arrandale i3—350 Processor (2.26 GHz, 3 MB L3 cache, 1066 MHz)—Dual Core 35 W (for
models 1.0 and 1.1 only)

597624—-001 Intel Arrandale i5-430 Processor (2.26 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 35 W
(for models 1.0 and 1.1 only)

598856-001 2 GB memory module (1066 MHz, DDR3) (for models 1.0 and 1.1 only)

598859-001 1 GB memory module (1066 MHz, DDR3)

599092-001 4 GB memory module (1066 MHz, DDR3) (for models 1.1 and 1.2 only)

600370-001 Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter
(BT3.0+HS ready) (for models 1.1 and 1.2 only)

602992-001 Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter (BT3.0+HS
ready) (for models 1.1 and 1.2 only)

603785-001 640 GB, 5400 rpm hard drive

603787-001 750 GB, 5400 rpm hard drive (for model 1.1 only)

605904-001 Bluetooth module cable (for model 1.0 only)

606013-001 Fan/heat sink assembly (includes replacement thermal material) for use with UMA systems
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606014-001 Fan/heat sink assembly (includes replacement thermal material) for use with discrete systems

609939-001 65-W AC adapter

609940-001 90-W AC adapter

612094-001 43.9-cm (17.3-in) HD, light-emitting diode display assembly for biscotti computer models

612095-001 43.9-cm (17.3-in) HD, light-emitting diode display assembly for matte black computer models

612097-001 High Definition display panel (includes display panel and backlight cables)

612098-001 Display back cover for use with biscotti computer models

612099-001 Display back cover for use with matte black computer models

612102-001 Display Bezel

612103-001 LCD cable (includes webcam module cable)

612104—-001 Display hinge kit (includes left and right display hinges)

612105-001 Display hinge covers

612106-001 Display rubber kit

612107-001 Display screw kit

612108-001 Wireless antenna kit (includes wireless antenna transceivers and cable)

612109-001 Webcam module

612110-001 Microphone (includes cable)

613584—-001 Intel Arrandale i3—370 Processor (2.4 GHz, 3 MB L3 cache, 1066 MHz)—Dual Core 35 W

613585-001 Intel Arrandale i5—450 Processor (2.4 GHz, 3 MB L3 cache, 1066 MHz)—Dual Core 35 W (for
models 1.0 and 1.1 only)

613586-001 Pentium Arrandale P6000 Processor (1.86 GHz, 3 MB, L3 cache 100 MHz) (for models 1.0 and
1.1 only)

613587-001 Pentium Arrandale P6100 Processor (2.0 GHz, 3 MB, L3 cache 100 MHz) (for models 1.1 and
1.2 only)

614548-001 Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with biscotti
computer models

614549-001 DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with
biscotti computer models

615082-001 160 GB, 7200 rpm hard drive (for models 1.0 and 1.1 only)

615083-001 250 GB, 7200 rpm hard drive

615084-001 320 GB, 7200 rpm hard drive

615085-001 500 GB, 7200 rpm hard drive

615086—-001 Hard Drive Hardware Kit (includes bracket and screws)

615847-001 HD 5430/1 G discrete system board with card reader 1.1 (for model 1.1 only)

615848-001 HD 5430/512 MB discrete system board with card reader 1.1 (for model 1.1 only)

615850-001 Keyboard for use in the United States (includes keyboard cable) (for models 1.1 and 1.2 only)
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Spare part number

Description

615850-031 Keyboard for use in the United Kingdom (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-041 Keyboard for use in Germany (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-051 Keyboard for use in France (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-061 Keyboard for use in Italy (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-071 Keyboard for use in Spain (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-121 Keyboard for use in French Canada (includes keyboard cable) (for models 1.1 and 1.2 only)

615850-131 Keyboard for use in Portugal (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-141 Keyboard for use in Turkey (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-171 Keyboard for use in Saudi Arabia (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-211 Keyboard for use in Hungary (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-221 Keyboard for use in Czech Republic (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-251 Keyboard for use in Russia (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-A41 Keyboard for use in Belgium (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-B31 Keyboard for use in international use (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-BA1 Keyboard for use in Adriatics (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-BB1 Keyboard for use in Israel (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-BG1 Keyboard for use in Switzerland (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-DH1 Keyboard for use in Norway (includes keyboard cable) (for models 1.0 and 1.1 only)

615850-DJ1 Keyboard for use in Greece (includes keyboard cable) (for models 1.0 and 1.1 only)

616480-001 Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with matte
black computer models

616482-001 DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with
matte black computer models

616485-001 Base enclosure with HDMI card reader and without modem for biscotti computer models

616488-001 Base enclosure with HDMI card reader and without modem for charcoal computer models (for
models 1.1 and 1.2 only)

616489-001 Base enclosure with HDMI card reader and without modem for matte black computer models

616490-001 Top cover (includes TouchPad board) for use in biscotti computer models

616492-001 Top cover (includes TouchPad board) for use in matte black computer models

616493-001 Touchpad button board (includes bracket and cable)

616494-001 USB board

616495-001 Power button board

616496-001 Power connector (includes cable)

616497-001 Plastics kit

616498-001 Speaker assembly (includes cable)
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Spare part number

Description

616499-001 Rubber kit (includes four rubber feet)

616500-001 Screw kit

616501-001 RTC battery

616502—-001 Cable kit

620538-001 43.9-cm (17.3-in) HD, light-emitting diode display assembly for charcoal computer models (for
models 1.1 and 1.2 only)

620539-001 Display back cover for use with charcoal computer models (for models 1.1 and 1.2 only)

620540-001 Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with charcoal
computer models (for models 1.1 and 1.2 only)

620541-001 DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with
charcoal computer models (for models 1.1 and 1.2 only)

620542-001 Top cover (includes TouchPad board) for use in charcoal computer models (for models 1.1 and
1.2 only)

622643-001 320 GB, 5400 rpm hard drive (for models 1.1 and 1.2 only)

625823-001 Intel Arrandale i3—380M Processor (2.53 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 35
W (for models 1.1 and 1.2 only)

625824-001 Intel Arrandale i5-560M Processor (2.66-3.2 GHz, 3 MB total L3 cache, 1066 MHz)—Dual
Core 35 W (for models 1.1 and 1.2 only)

625825-001 Intel Arrandale i5-580M Processor (2.66-3.33 GHz, 3 MB total L3 cache, 1066 MHz)—Dual
Core 35 W (for models 1.1 and 1.2 only)

625831-001 Intel Pentium P6200 Processor (2.13 GHz, 3 MB, L3 cache 100 MHz) (for models 1.1 and 1.2
only)

626039-001 Intel Core i5—-460M Processor (2.53 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 35 W
(for models 1.1 and 1.2 only)

629120-001 HD 5430/512 MB discrete system board with card reader (for model 1.0 only)

629121-001 HD 5430/1 G discrete system board with card reader (for model 1.0 only)

629122-001 HD UMA system board with card reader (for model 1.2 only)

630948-001 HD 1G discrete system board with card reader (for model 1.2 only)

630949-001 HD 512 discrete system board with card reader (for model 1.2 only)

630950-001 HD UMA system board with card reader (for model 1.2 only)

634363-001 Thermal pads

634692-001 Intel Arrandale i3-390M processor (2.66 GHz 3MB L3 cache 35W)-Dual core 35 W (for model
1.2 only)

634693-001 Intel Arrandale i5-480M processor (2.66 GHz 3MB L3 cache)-Dual core 35 W (for model 1.2
only)

635500-001 Pentium Arrandale processor P6300 2.26 GHZ 3M L3 cache) (for model 1.2 only)
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
The following tools are needed to complete the removal and replacement procedures:
e  Flat-bladed screwdriver
e  Magnetic screwdriver

e  Phillips PO and P1 screwdrivers

Service considerations

Before disassembly or assembly procedures, review and adhere to all service considerations.

B NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when

handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors

/A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

/A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage might have occurred.

An electronic device exposed to ESD might not be affected at all and can work perfectly throughout a
normal cycle. Or the device might function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when removing or installing internal components,
observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/A CAUTION: A product can be degraded by as little as 700 V.

ENWW

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000V
Motions of bench worker 6,000 V 800V 400 V
Removing DIPS from plastic tube 2,000 V 700V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.
Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

e  When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm +£10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

e  When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e Antistatic tape

e Antistatic smocks, aprons, and sleeve protectors

e  Conductive bins and other assembly or soldering aids

e  Nonconductive foam

e  Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e Field service kits

e  Static awareness labels

e Material-handling packages

e Nonconductive plastic bags, tubes, or boxes

e Metal tote boxes

e Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 75 screws, in 12 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number

The serial number label, located in the battery bay of the computer, provides important information
that you may need when contacting technical support.
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Component

Description

(1

Product name

The name affixed to the front of the computer.

)

Serial number (s/n)

An alphanumeric identifier that is unique to each product.

@)

Part number/Product number (p/n)

This number provides specific information about the product’s
hardware components. The part number helps a service technician
to determine what components and parts are needed.

(4)

Warranty period

The duration of the warranty period for the computer.

Model description

An alphanumeric identifier used to locate documents, drivers, and
support for the computer.
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Computer feet

Description Spare part number

Rubber Feet Kit 616499-001

The computer feet are adhesive-backed rubber pads. The feet attach to the base enclosure in the
locations illustrated below.
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Battery

Description Spare part number
6 cell, 2.20 Ah, 47 Wh 593553-001
6 cell, 2.55 Ah, 55 Wh 593554-001

Before disassembling the computer:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside down on a flat surface.
2. Slide the battery release latch (1) to release the battery.

3. Pivot the battery (2) upward and lift it out of the computer (3).

To insert the battery, insert the rear edge of the battery into the battery bay and pivot the front edge
downward until the battery is seated. The battery release latch automatically locks the battery into
place.
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Hard drive

Br NOTE: The hard drive spare part kit includes a hard drive bracket and hard drive connector. The
hard drive bracket and hard drive connector, as well as the hard drive bracket screws, are also
available in the Hard Drive Hardware Kit.

Description Spare part number
750 GB, 5400 rpm (for model 1.1 only) 603787-001
640 GB, 5400 rpm 603785-001
500 GB, 7200 rpm 615085-001
320 GB, 5400 rpm (for model 1.1 only) 622643-001
320 GB, 7200 rpm 615084-001
250 GB, 7200 rpm 615083-001
160 GB, 7200 rpm (for models 1.0 and 1.1 only) 615082-001
Hard drive hardware kit (not illustrated, includes connector, bracket, and screws) 615086-001

Before removing the hard drive:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

Remove the hard drive:
1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.5%6.0 captive screws (1) that secure the hard drive cover to the
computer.
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3. Lift the left side of the hard drive cover (2), swing it forward, and remove the cover (3). The hard
drive cover is included in the plastics kit, spare part number 616497-001.

4. Remove the four Phillils PM2.5x5.0 screws (1) that secure the hard drive to the computer. Use
the mylar tabs (2) to lift up the hard drive. Disconnect the hard drive cable from the system board
(3) and lift the hard drive out (4) of the hard drive bay.

5. Toreplace the hard drive bracket, remove the four Phillips PM3.0%4.0 screws (1) that secure the
hard drive bracket to the hard drive
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6. Grasp the two attached Mylar tabs and pull the bracket straight up to remove it from the hard
drive (2).

Reverse this procedure to install the hard drive.
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Optical drive

B NOTE: The optical drive spare part kit includes an optical drive bezel and optical drive bracket.

Description Spare part number

DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe for use with:

e  Biscotti computer models 614549-001
e  Matte black computer models 616482-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 620541-001

Blu-ray ROM with LightScribe DVD+R/RW SuperMulti Double-Layer Drive for use with:

e  Biscotti computer models 614548-001
e  Matte black computer models 616480-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 620540-001

Before removing the optical drive:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the wireless/memory module compartment cover (see Memory module on page 51).

Remove the optical drive:
1. Position the computer upside down with the front toward you.
2. Remove the Phillips PM2.5x5.0 screw (1) that is identified by the optical disk icon.

3. Insert a thin tool, such as a screw driver (2), into the release access slot in the hard drive bay.
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4. Grasp the bezel and slide the optical drive out of the computer (3).

5. To replace the optical drive bracket, position the optical drive with the optical drive bracket
toward you.

6. Remove the two Phillips PM2.0x3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).
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Reverse the above procedure to reassemble and install the optical drive.
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WLAN module

Description Spare part number
Atheros AR9285 802.11b/g/n 1x1 WiFi Adapter 518436-002
Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 WLAN module 593530-001
Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter (for models 1.0 and 1.1 only) 593533-001
Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter 593836-001
Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter 600370-001

(BT3.0+HS ready) (for models 1.1 and 1.2 only)

Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter 602992-001
(BT3.0+HS ready) (for models 1.1 and 1.2 only)

Before removing the WLAN module:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

Remove the WLAN module:
1. Turn the computer upside down with the front toward you.

2. Loosen the two Phillips PM2.5%x6.0 captive screws (1) that secure the wireless/memory module
compartment cover.

3. Lift the back side of the memory module cover (2).
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4. Lift the cover off the computer (3). The wireless/memory module compartment cover is included
in the plastics kit, spare part number 616497-001.

5. Disconnect the main antenna cable (1) and the auxiliary antenna cable (2) from the wireless
module.

6. Remove the Phillips PM2.0x3.0 screw (3) that secures the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)
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7. Remove the WLAN module (4) by pulling it away from the slot at an angle.

/A CAUTION: To prevent an unresponsive system, replace the wireless module only with a
wireless module authorized for use in the computer by the governmental agency that regulates
wireless devices in your country or region. If you replace the module and then receive a warning
message, remove the module to restore computer functionality, and then contact technical
support through Help and Support.

B NOTE: WLAN modules are designed with a notch (5) to prevent incorrect insertion into the
WLAN module slot.

Reverse this procedure to install a WLAN module.
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Memory module

Description Spare part number
1 GB, 1066 MHz DDR3 598859-001
2 GB, 1066 MHz DDR3 598856-001
4 GB, 1066 MHz DDR3 (for models 1.1 and 1.2 only) 599092-001

Before removing the memory module:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).
Remove the memory module:
1. Turn the computer upside down with the front toward you.

2. Loosen the two Phillips PM2.5%6.0 captive screws (1) that secure the wireless/memory module
compartment cover to the computer.

3. Lift the back side of the memory module cover (2)

4. Lift the cover off the computer (3). The wireless/memory module compartment cover is included
in the plastics kit, spare part number 616497-001.

B NOTE: Small tabs hold the cover in place. Firmly pull up on the cover to release the tabs.

5. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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6.

Remove the module (2) by pulling it away from the slot at an angle.

Er NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the

memory module slot.

Reverse this procedure to install a memory module.

RTC battery
Description Spare part number
RTC battery 616501-001

Before removing the RTC battery:

1.

4,

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 42).

Remove the RTC battery:

1.
2,
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Turn the computer upside down with the front toward you.

Loosen the two Phillips PM2.5%6.0 captive screws (1) that secure the wireless/memory module
compartment cover to the computer.

Lift the back side of the memory module cover (2)
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4. Lift the cover off the computer (3). The wireless/memory module compartment cover is included
in the plastics kit, spare part number 616497-001.

E¥ NOTE: Small tabs hold the cover in place. Firmly pull up on the cover to release the tabs.

5.  Unplug the RTC battery from the system board (1).

6. Use a sharp, non-conductive, tool to release the RTC battery from the adhesive material that
secures the RTC battery to the system board..

7.  Lift the battery (2) out of the computer.

Reverse this procedure to install the RTC battery.
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Keyboard

Description Spare part number
For use in Adriatics (for models 1.0 and 1.1 only) 615850-BA1
For use in Belgium (for models 1.0 and 1.1 only) 615850-A41
For use in the Czech Republic (for models 1.0 and 1.1 only) 615850-221
For use in France (for models 1.0 and 1.1 only) 615850-051
For use in French Canada (for models 1.1 and 1.2 only) 615850-121
For use in Germany (for models 1.0 and 1.1 only) 615850-041
For use in Greece (for models 1.0 and 1.1 only) 615850-DJ1
For use in Hungary (for models 1.0 and 1.1 only) 615850-211
For International use (for models 1.0 and 1.1 only) 615850-B31
For use in Israel (for models 1.0 and 1.1 only) 615850-BB1
For use in Italy (for models 1.0 and 1.1 only) 615850-061
For use in Norway (for models 1.0 and 1.1 only) 615850-DH1
For use in Portugal (for models 1.0 and 1.1 only) 615850-131
For use in Russia (for models 1.0 and 1.1 only) 615850-251
For use in Saudi Arabia (for models 1.0 and 1.1 only) 615850-171
For use in Spain (for models 1.0 and 1.1 only) 615850-071
For use in Switzerland (for models 1.0 and 1.1 only) 615850-BG1
For use in Turkey (for models 1.0 and 1.1 only) 615850-141
For use in the United Kingdom (for models 1.0 and 1.1 only) 615850-031
For use in the United States (for models 1.1 and 1.2 only) 615850-001

Before removing the keyboard:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the hard drive (see Hard drive on page 43).

6. Remove the wireless/memory module compartment cover (see WLAN module on page 48).

Remove the keyboard:

1. Turn the computer upside down with the front toward you.
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2. Remove the three Phillips PM2.5%5.0 screws that secure the keyboard to the computer.

3. Turn the computer display-side up with the front toward you.
4. Open the computer as far as possible.

5. Release the tabs along the left (1) and right (2) edges of the keyboard using a thin flat-bladed
screwdriver.

6. Lift the rear edge of the keyboard (3), and set the keyboard back towards the display (4).
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7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover

ENWW

Description Spare part number
For use with biscotti computer models 616490-001
For use with matte black computer models 616492-001
For use with charcoal computer models (for models 1.1 and 1.2 only) 620542-001

Before removing the switch cover:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting AC adapter from the computer.

a.

b.

g.

Remove the following components:

Battery (see Battery on page 42)

Hard drive (See Hard drive on page 43)

Optical drive (see Optical drive on page 46)

WLAN module (see WLAN module on page 48)

Memory module (see Memory module on page 51)

RTC battery (see RTC battery on page 52)

Keyboard (see Keyboard on page 54)

Remove the top cover:

1. Turn the computer upside down with the front toward you.
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2.  Remove four Phillips PM2.5x3 and three Phillips PM2.5x6.5 screws in the battery bay, and
remove ten Phillips PM2.5x6.5 screws on the base enclosure. The top cover screws are
identified by a triangle icon embossed on the base enclosure.

3. Turn the computer display-side up with the front toward you.
4. Open the computer as far as possible.

5. Remove the four Phillips PM2.5%6.0 screw that secures the top cover to the computer.
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6. Release the power button ZIF connector (1), speaker cable (2), touchpad ZIF connector (3), and
touchpad button ZIF connector (4).

7. Lift the rear edge of the top cover (1) until the top cover disengages from the base enclosure.
Remove the top cover (2).

Er NOTE: The TouchPad is glued to the top cover and is included with the top cover spare part.

Reverse this procedure to install the switch cover.
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Speaker assembly

Description Spare part number

Speaker assembly (includes cable) 616498-001

Before removing the speaker assembily:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a. Hard drive (see Hard drive on page 43)

b. Optical drive (see Optical drive on page 46)

c. Keyboard (see Keyboard on page 54)

d. Top cover (see Top cover on page 57)

Remove the speaker assembly:
1. Turn the top cover upside down.

2. Remove the two Phillips PM2.5%3.0 screws (1) that secure the speaker assembly to the top
cover.

3. Lift up and remove the speakers (2).

Reverse this procedure to install the speaker assembly.
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Power button board
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Description Spare part number

Power button board 616495-001

Before removing the power button board:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a.
b.
c.

d.

Hard drive (see Hard drive on page 43)

Optical drive (see Optical drive on page 46)

Keyboard (see Keyboard on page 54)

Top cover (see Top cover on page 57)

Remove the power button board:

1. Turn the top cover upside down with the rear edge toward you.

2.  Remove the Phillips PM2.0x3.0 screw (1) that secures the power button board to the top cover.

3. Lift up and remove the power button board (2).

o ‘e
A

Reverse this procedure to install the power button board.
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TouchPad button board

Description Spare part number

Touchpad button board (includes bracket and cable) 616493-001

Before removing the TouchPad button board:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 42).

Remove the following components:

a. Hard drive (see Hard drive on page 43)

b. Optical drive (see Optical drive on page 46)

c. Keyboard (see Keyboard on page 54)

d. Top cover (see Top cover on page 57)

Remove the TouchPad button board:

1.
2.

Turn the top cover upside down with the front toward you.

Remove the four Phillips PM2.0%3.0 screws (1) that secure the TouchPad bracket to the top
cover.

Lift up and remove the TouchPad button board bracket (2). The TouchPad button is fused on the
TouchPad button board bracket.

T —

T

I
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Reverse the above procedure to reassemble and install the TouchPad button board.
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Modem module

Description Spare part number

56K V.92 data/fax modem (select models only) (for model 1.0 only) 510100-001

Before removing the modem module:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a. Hard drive (see Hard drive on page 43)

b. Optical drive (see Optical drive on page 46)

c. Keyboard (see Keyboard on page 54)

d. Top cover (see Top cover on page 57)

Remove the modem module:
1. Turn the computer upright with the front toward you.

2. Remove the two Phillips PM2.0x3.0 screws (1) that secure the modem module to the system
board.

3.  Lift up on the front of the modem module (2) to disconnect it from the system board.
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Reverse the above procedure to install the modem module, and be sure that the connector on the
bottom of the modem module connects firmly into the system board.
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USB board

Description Spare part number

USB board 616494-001

Before removing the USB board:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a. Hard drive (see Hard drive on page 43)

b. Optical drive (see Optical drive on page 46)

c. Keyboard (see Keyboard on page 54)

d. Top cover (see Top cover on page 57)

Remove the USB board:
1. Position the computer upright with the right side toward you.
Disconnect the USB board cable (1) from the system board.

2
3.  Remove the Phillips PM2.5%6.0 screw (2) that secures the USB board to the base enclosure.
4

Lift the USB board (3) straight up to remove it from the computer. The USB cable is available
with the cable kit using spare part number 616502-001

1— ©
|
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Reverse this procedure to install the USB board.
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Power connector
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Description Spare part number

Power connector (includes cable) 616496-001

Before removing the power connector cable:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a.
b.
c.

d.

Hard drive (see Hard drive on page 43)

Optical drive (see Optical drive on page 46)

Keyboard (see Keyboard on page 54)

Top cover (see Top cover on page 57)

Remove the power connector cable:

1. Turn the computer upright with the right side toward you.

2. Disconnect the power connector cable (1) from the system board.

3. Lift the power connector (2) from the clips built into the base enclosure.

Reverse this procedure to install the power connector.
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Bluetooth module

Description Spare part number
Bluetooth module (for model 1.0 only) 537921-001
Bluetooth module cable (for model 1.0 only) 605904-001

Before removing the Bluetooth module:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).
5. Remove the following components:

a. Hard drive (see Hard drive on page 43)

b. Optical drive (see Optical drive on page 46)

c. Keyboard (see Keyboard on page 54)

d. Top cover (see Top cover on page 57)

Remove the power connector cable:
1. Turn the computer upright with the right side toward you.
2. Disconnect the Bluetooth module cable (1) from the system board.

3.  Remove the Bluetooth module (2).

Reverse this procedure to install the Bluetooth module.
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Display assembly

Description Spare part number

39.6-cm (15.6-in) High Definition (HD), light-emitting diode (LED) display assembly for use in:

e  Biscotti computer models 612094-001
e  Matte black computer models 612095-001
e  Charcoal computer models (for models 1.1 and 1.2 only) 620538-001

Before removing the display assembly:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

Remove the battery (see Battery on page 42).

Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 48).

Remove the following components:

a. Hard drive (see Hard drive on page 43)

b. Optical drive (see Optical drive on page 46)

c. Keyboard (see Keyboard on page 54)

d. Top cover (see Top cover on page 57)

Remove the display assembly:

1.
2,

ENWW

Turn the computer display-side up, with the front toward you.
Open the display as far as possible.

Disconnect the display panel cable (1) and the microphone cable (2) from the system board and
remove it from its routing channel.

Pull the antenna cables through the opening in the top cover (3) and disengage the cables from
the clip in the routing channel leading to the display hinge (4).
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5. Disconnect the webcam cable (5) from the system board and release it from the clips that attach
it to the system board.

/A CAUTION: Support the display assembly when removing the display screws in the following
steps. Failure to support the display assembly can result in damage to the assembly and other

components.

6. Remove the five black Phillips PM2.5%7.0 screws (1) that secure the display assembly to the
computer.

7. Lift the display panel (2) straight up to remove it.

Reverse this procedure to install the display assembly.
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8. To replace any of the display assembly internal components, remove the following screw covers
and screws:

(1) Two mylar screw covers on the display bezel bottom edge
(2) Two Phillips PM2.5%4.0 screws

The display screw covers are included in the display rubber kit, spare part number 612106-001.

—_—
|
T

L

9. Flex the inside edge of the top (1), the left and right sides (2), and the bottom (3) of the display
bezel until the bezel disengages from the display back cover.

10. Remove the display bezel (4).

Reverse this procedure to install the display bezel.

11. To replace the webcam module (select models only), lift the webcam module as far from the
display enclosure as the webcam module cable allows.
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12. Disconnect the webcam module cable (1) from the webcam module, and remove the webcam
module (2). The webcam module is available using spare part number 612109-001.

IR &

Reverse this procedure to install the webcam module.

13. To replace the display hinge covers, remove the two Phillips PM2.5%6.0 screws (1) that secure
each hinge to the display enclosure.

14. Remove the display hinge covers (2). The display hinge covers are available using spare part
number 612105-001.

Reverse this procedure to install the display hinge covers.

15. To replace the display panel, remove eight phillips PM2.5%6.0 screws (1) that secure the display
panel to the display enclosure.
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16. Remove the display panel (2) from the display enclosure. The display panel is available using
the spare part number 612097-001.

Reverse this procedure to install the display panel.

17. To replace the display panel brackets, remove the three Phillips PM2.0%3.0 screws (1) that
secure each bracket to the display panel.

18. Remove the display panel brackets (2) from the display panel. The display panel brackets are
available using spare part number 612104-001.

Reverse this procedure to install the display panel brackets.

19. To replace the wireless antenna transceivers, lift up on the silver transceiver (1) and release the
adhesive material from the display cover (2).

ENWW Component replacement procedures 73



20. Lift up to remove the antenna transceivers (3). The wireless antenna transceivers with cable is
available using spare part number 612108-001.

Reverse this procedure to install the display wireless antenna transceivers.
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System board

Br NOTE: The system board spare part kit includes UMA or discrete graphics subsystem memory and

ENWW

replacement thermal material.

Description Spare part number
HD 5430/1 G discrete system board with card reader 1.1 (for model 1.1 only) 615847-001
HD 5430/512 MB discrete system board with card reader 1.1 (for model 1.1 only) 615848-001
HD 5430/512 MB discrete system board with card reader (for model 1.0 only) 629120-001
HD 5430/1 G discrete system board with card reader (for model 1.0 only) 629121-001
HD UMA system board with card reader (for model 1.2 only) 629122-001
HD 1G discrete system board with card reader (for model 1.2 only) 630948-001
HD 512 MB discrete system board with card reader (for model 1.2 only) 630949-001
HD UMA system board with card reader (for model 1.2 only) 630950-001

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

e RTC battery (see RTC battery on page 52)

e  Memory modules (see Memory module on page 51)

e  WLAN module (see WLAN module on page 48)

e  Modem module (see Modem module on page 63)

Before removing the system board:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a. Hard drive (see Hard drive on page 43)

b. Optical drive (see Optical drive on page 46)

c.  WLAN module (see WLAN module on page 48)

d. Memory module (see Memory module on page 51)

e. RTC battery (see RTC battery on page 52)

f. Keyboard (see Keyboard on page 54)

g. Top cover (see Top cover on page 57)
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h. Modem module (see Modem module on page 63)

i.  Display assembly (see Display assembly on page 69)

Remove the following cables from the system board:

e  Power connector cable (see Power connector on page 67)

e USB board cable (see USB board on page 65)

e  Bluetooth module cable (see Bluetooth module on page 68)

Remove the system board:

1. Turn the computer upright with the right side toward you.

2. Remove the three Phillips PM2.5x4.0 (1) screws that secure the system board to the computer.
3. Grasp the right edge (2) of the system board.
4

Lift the system board (3), and pull it away from the base enclosure at an angle.

Reverse this procedure to install the system board.
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5. To replace the modem module cable, remove the RJ-11 connector cable from the clips (1), and
then lift the connector straight up (2) and out of the computer. The modem module cable is
available with the cable kit using spare part number 616502-001.

Reverse this procedure to install the modem module cable.

6. To replace the optical drive cable, remove the two Phillips PM2.0x6.0 screws (1), and then lift
the connector straight up (2) and out of the computer. The optical drive cable is available with
the cable kit using spare part number 616502-001.

Reverse this procedure to install the optical drive cable.

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

e  Fan/heat sink assembly (see Fan/heat sink assembly on page 79)

e  Processor (see Processor on page 83)
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Reverse the preceding procedure to install the system board.
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Fan/heat sink assembly

Description Spare part number

Fan/heat sink assembly (includes replacement thermal material) for use only with computer 606013-001
models with UMA graphics subsystem memory

Fan/heat sink assembly (includes replacement thermal material) for use only with computer 606014-001
models with discrete graphics subsystem memory

Thermal pad 634363-001

Before removing the fan/heat sink assembly:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on
the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC
outlet and then disconnecting the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5.  Remove the following components:

a.

b.

g.

Hard drive (see Hard drive on page 43)

Optical drive (see Optical drive on page 46)

Keyboard (see Keyboard on page 54)

Top cover (see Top cover on page 57)

Speaker assembly (see Speaker assembly on page 60)

Display assembly (see Display assembly on page 69)

System board (see System board on page 75)

Remove the fan/heat assembly (fan/heat sink appearance might vary):

Br NOTE: Steps 1 through 4 apply only to computer models equipped with graphics subsystems
having UMA memory.

1. Turn the system board right-side up, with the front toward you.

ENWW
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2. Disconnect the fan cable from the system board.

3. Follow the sequence embossed on heat sink to loosen the four Phillips PM2.5x7.0 captive
screws (1) that secure the fan/heat sink assembly to the system board.

Br NOTE: Due to the adhesive quality of the thermal material located between the fan/heat sink
assembly and system board components, it might be necessary to move the fan/heat sink
assembly from side to side to detach the assembly.

4. Remove the fan/heat sink assembly (2) by lifting straight up.

B NOTE: Steps 5 through 8 apply only to computer models equipped with graphics subsystems
having discrete memory.

5. Turn the system board right-side up, with the front toward you.
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6. Disconnect the fan cable from the system board.

7. Loosen the two Phillips captive screws (1) and four Phillips spring-loaded captive screws (2) that
secure the fan/heat sink assembly.

Bf NOTE: Due to the adhesive quality of the thermal material located between the fan/heat sink
assembly and system board components, it might be necessary to move the fan/heat sink
assembly from side to side to detach the assembily.

8. Remove the fan/heat sink assembly (3) by lifting straight up.

Reverse this procedure to install the fan/heat sink assembly.

The thermal material must be thoroughly cleaned from the surface of the fan/heat sink assembly (1),
(3) and the processor (2) and video components (4) each time the fan/heat sink assembly is
removed. Thermal pads and thermal paste must be installed on all surfaces before the fan/heat sink
assembly is reinstalled.
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B NOTE: Thermal pads and thermal paste are included with all fan/heat sink assembly, system board,
and processor spare part kits.

The following illustration shows the locations for thermal material on systems with UMA graphics
subsystems.

-

The thermal material must be thoroughly cleaned from the surface of the fan/heat sink assembly (1)
and (3), and the processor component (2), each time the fan/heat sink assembly is removed. Thermal
pads and thermal paste must be installed on all surfaces before the fan/heat sink assembly is
reinstalled.

The following illustration shows the locations for thermal material on systems with discrete graphics
subsystems.

o
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Processor

B NOTE: All processor spare part kits include thermal material.
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Description Spare part number
Intel Arrandale i7-620M Processor (2.66 GHz, 4 MB total L3 cache, 1066 MHz)—Dual Core 35 W  587259-001
Intel Arrandale i5-520M Processor (2.4 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 35 W  594187-001
(for models 1.0 and 1.1 only)

Intel Arrandale i5-540M Processor (2.53 GHz, 3 MB total L3 cache, 1066 MHz)—Dual core 35 W 594188-001
(for models 1.0 and 1.1 only)

Intel Arrandale i3—-350 Processor (2.26 GHz, 3 MB L3 cache, 1066 MHz)—Dual Core 35 W (for 597623-001
models 1.0 and 1.1 only)

Intel Arrandale i5-430 Processor (2.26 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 35 W 597624-001
(for models 1.0 and 1.1 only)

Intel Arrandale i3—-370 Processor (2.4 GHz, 3 MB L3 cache, 1066 MHz)—Dual Core 35 W 613584-001
Intel Arrandale i5-450M Processor (2.4 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 35 W 613585-001
(for models 1.0 and 1.1 only)

Pentium Arrandale P6000 Processor (1.86 GHz, 3 MB, L3 cache 100 MHz) (for models 1.0 and 613586-001
1.1 only)

Pentium Arrandale P6100 Processor (2.0 GHz, 3 MB, L3 cache 100 MHz) (for models 1.1 and 1.2  613587-001
only)

Intel Arrandale i3—380M Processor (2.53 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 35 W 625823-001
(for models 1.1 and 1.2 only)

Intel Arrandale i5-560M Processor (2.66—-3.2 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 625824-001
35 W (for models 1.1 and 1.2 only)

Intel Arrandale i5-580M Processor (2.66—3.33 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core = 625825-001
35 W (for models 1.1 and 1.2 only)

Intel Pentium P6200 Processor (2.13 GHz, 3 MB, L3 cache 100 MHz) (for models 1.1 and 1.2 625831-001
only)

Intel Core i5—-460M Processor (2.53 GHz, 3 MB total L3 cache, 1066 MHz)—Dual Core 35 W (for  626039-001
models 1.1 and 1.2 only)

Intel Arrandale i3-390M Processor (2.66 GHz 35W 3 MB L3 cache)—Dual core 35 W (for model 634692-001
1.2 only)

Intel Arrandale i5-480M Processor (2.66 GHz 35W 3 MB L3 cache)—Dual core 35 W (for model 634693-001
1.2 only)

Pentium Arrandale P6300 (2.26 GHz 3 MB L3 cache) (for model 1.2 only) 635500-001

Before removing the processor:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn on

the computer, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first disconnecting the power cord from the AC

outlet and then disconnecting the AC adapter from the computer.
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4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a. Hard drive (see Hard drive on page 43)

b. Optical drive (see Optical drive on page 46)

c. Keyboard (see Keyboard on page 54)

d. Top cover (see Top cover on page 57)

e. Speaker assembly (see Speaker assembly on page 60)

f. Display assembly (see Display assembly on page 69)

g. System board (see System board on page 75)

h. Fan/heat sink assembly (see Fan/heat sink assembly on page 79)

Remove the processor:
1. Turn the processor locking screw (1) one-half turn counterclockwise until you hear a click.

2. Lift the processor (2) straight up and remove it.

B NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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5

Setup Utility

Computer Setup in Windows 7

To view the drives installed on the computer, select Start > Computer.

On models with a secondary hard drive (drive D), the optical drive becomes drive E. The next drive
added to the system, such as a new USB drive, is assigned the next available drive letter.

Starting Setup Utility

Setup Utility is a ROM-based information and customization utility that can be used even when the
Windows operating system is not working.

The utility reports information about the computer and provides settings for startup, security, and
other preferences.

To start Setup Utility:

A Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the 10 key.

1. Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the esc key.

2. When the Startup Menu displays, press the f10 key.

Using Setup Utility

Changing the language of Setup Utility

ENWW

The following procedure explains how to change the language of Setup Utility. If Setup Utility is not
already running, begin at step 1. If Setup Ultility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the 10 key.

Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the esc key. When
the Startup Menu displays, press the f10 key.

2. Use the arrow keys to select System Configuration > Language, and then press the enter key.
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Use the arrow keys to select a language, and then press enter key.
When a confirmation prompt with your language selected displays, press the enter key.

To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press the enter key.

Changes goes into effect immediately.

Navigating and selecting in Setup Utility

Because Setup Utility is not Windows based, it does not support the TouchPad. Navigation and
selection are by keystroke.

To choose a menu or a menu item, use the arrow keys.

To choose an item in a list or to toggle a field, for example an Enable/Disable field, use either the
arrow keys or the 5 or 16 keys.

To select an item, press the enter key.
To close a text box or return to the menu display, press the esc key.

To display additional navigation and selection information while Setup Ultility is open, press the
1 key.

Displaying system information

The following procedure explains how to display system information in Setup Utility. If Setup Utility is
not open, begin at step 1. If Setup Ultility is open, begin at step 2.

1.

Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the f10 key.

Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the esc key. When
the Startup Menu displays, press the f10 key.

Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press the enter key.
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Restoring default settings in Setup Utility

The following procedure explains how to restore Setup Utility default settings. If Setup Ultility is not
already running, begin at step 1. If Setup Ultility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the 10 key.

Open Setup Utility by turning on or restarting the computer. When the Press the ESC key for
Startup Menu message displays in the lower-left corner of the screen, press the esc key. When
the Startup Menu displays, press the f10 key.

2. Use the arrow keys to select Exit > Load Setup Defaults, and then press the enter key.
3. When the Setup Confirmation appears, press the enter key.

4. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press the enter key.

Setup Utility default settings go into effect when the computer restarts.

Br NOTE: Password, security, and language settings are not changed when you restore the factory
default settings.
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Exiting Setup Utility

You can exit Setup Utility with or without saving changes.

e To exit Setup Utility and save changes from the current session:

If the Setup Utility menus are not displayed, press the esc key to return to the menu display.
Then use the arrow keys to select Exit > Exit Saving Changes, and then press the enter key.

e  To exit Setup Utility without saving changes from the current session:

If the Setup Utility menus are not displayed, press the esc key to return to the menu display.
Then use the arrow keys to select Exit > Exit Discarding Changes, and then press the enter

key.

After either choice, the computer restarts in Windows.

Setup Utility menus

The menu tables in this section provide an overview of Setup Ultility options.

EY NOTE: Some of the Setup Utility menu items listed in this chapter might not be supported by the

computer.

Main menu

Select

To do this

System information

e View and change the system time and date.
e View identification information about the computer.
e View specification information about the processor, memory size,

system BIOS, and keyboard controller version (select models
only).

Security menu

Select

To do this

Administrator password

Enter, change, or delete an administrator password.

Power-On password

Enter, change, or delete a power-on password.
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System Configuration menu

Select

To do this

Language Support

Change the language of Setup Utility.

Button Sound (select models only)

Enable/disable the capacitive button tapping sound.

Virtualization Technology (select models only)

Enable/disable the processor Virtualization Technology.

Processor C6 State (select models only)

Enable/disable the processor C6 sleep state.

LAN Power Saving (select models only)

Enable/disable LAN Power Saving. When enabled, saves power when
the computer is in DC mode.

Card Reader/1394 Power Saving (select models
only)

Enable/disable Card Reader/1394 Power Saving.

Fan Always On

Enabled/disable Fan Always On. When enabled, the computer fan will
always be on.

Action Keys Mode

Enable/disable Action Keys Mode.

Boot Options

Set the following boot options:

e  POST hotkey delay (sec.)—Set the delay for the f1, 2, 9, f10, f11,
and f12 functions of Setup Utility in intervals of 5 seconds each (0,
5,10, 15, 20).

e  CD-ROM Boot—Enable/disable boot from CD-ROM.

e  Floppy Boot—Enable/disable boot from diskette.

° Internal Network Adapter Boot—Enable/disable boot from the
internal network adapter.

o  Boot Order—Set the boot order for:
° Notebook Hard Drive
° Internal CD/DVD ROM Drive
° USB Diskette on Key/USB Hard Disk
o USB CD/DVD ROM Drive
° USB Floppy

° Network Adapter

Diagnostics menu

ENWW

Select

To do this

Hard Disk Self Test

Run a comprehensive self-test on the hard drive.

NOTE: On models with two hard drives, this menu option is called the
Primary Hard Disk Self Test.

Secondary Hard Disk Self Test (select models
only)

Run a comprehensive self-test on a secondary hard drive.

Memory Test

Run a diagnostic test on the system memory.

Computer Setup in Windows 7 89



Computer Setup in Linux

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

Ef NOTE: Some of the Computer Setup menu items listed in this guide might not be supported by the
computer.

NOTE: Pointing devices are not supported in Computer Setup. Use the keyboard to navigate and
make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup:
1. Turn on or restart the computer.

2. Before the operating system opens and when the F10=ROM Based Setup message displays in
the lower-left corner of the screen, press the f10 key.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing the 10 key
when the F10 = ROM Based Setup message appears in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

e To choose a menu or a menu item, use the arrow keys.
e To select an item, press the enter key.

e To close open dialog boxes and return to the main Computer Setup screen, press the esc
key.

e  To view navigation information, press the f1 key.

e To change the language, press the 2 key.
2. Select the File, Security, Diagnostics, or System Configuration menu.
3. To exit Computer Setup, choose one of the following methods:

e  To exit Computer Setup without saving your preferences, use the arrow keys to select File
> Ignore Changes And Exit. Then follow the instructions on the screen.

e To save your preferences and exit Computer Setup, use the arrow keys to select File >
Save Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
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Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory:

1. Open Computer Setup by turning on or restarting the computer, and then pressing the f10 key
when the F10 = ROM Based Setup message displays in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press the enter key.
3. When the confirmation dialog box opens, press the 10 key.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Br NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

Bf NOTE: Some of the Computer Setup menu items listed in this chapter might not be supported by
the computer.

File menu

Select To do this

System information e View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore Changes And Exit Cancel any changes entered during the current session, and
then exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session, and

then exit and restart the computer. Changes go into effect
when the computer restarts.
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Security menu

B NOTE: Some of the menu items listed in this section might not be supported by the computer.

Select

To do this

Setup Password

Enter, change, or delete a setup password.

Power-On Password

Enter, change, or delete a power-on password.

Password Options

e  Enable/disable stringent security.

° Enable/disable the password requirement on computer
restart.

DriveLock Passwords

e  Enable/disable DriveLock on any computer hard drive.

e  Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e  Fast: Runs the Disk Sanitizer erase cycle once.
e  Optimum: Runs the Disk Sanitizer erase cycle 3 times.

e  Custom: Allows you to select the desired number of
Disk Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

Diagnostics menu
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Select

To do this

HDD Self-Test Options

Run a comprehensive self-test on any hard drive in the
system or on any optional MultiBay hard drive.

Memory Check

Run a comprehensive check on system memory.

Computer Setup in Linux
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System Configuration menu

B NOTE: Some of the listed System Configuration options might not be supported by the computer.

Select To do this
Language Change the Computer Setup language.
Boot options e Setanf9, f10, and f12 delay when starting up.

Enable/disable CD-ROM boot.
Enable/disable floppy boot.
Enable/disable internal network adapter boot.

Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

Set the Express Boot Popup delay in seconds.
Set the boot order.

° 1st boot device—USB CD-ROM

° 2nd boot device—USB floppy

° 3rd boot device—USB SuperDisk

° 4th boot device—Notebook hard drive

° 5th boot device—USB hard disk

° 6th boot device—Network controller

Device Configurations °

Swap the functions of the fn key and left ctrl key.

Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when the operating system is not running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

Enable/disable BIOS DMA data transfers.

Enable/disable fan always on while connected to an AC
outlet.

Enable/disable data execution prevention.
Enable/disable LAN power saving mode.
Enable/disable SATA Native Mode.
Enable/disable Dual Core CPU.

Enable/disable HDD translation mode.
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Select

To do this

Built-in device options

Enable/disable embedded WLAN Device Radio.
Enable/disable embedded Bluetooth Device Radio.
Enable/disable Network Interface Controller (NIC)
Enable/disable LAN/WLAN Switching.
Enable/disable Wake on LAN.

Enable/disable the integrated camera (webcam)

Port options

Enable/disable USB port.

Enable/disable ExpressCard slot.

Computer Setup in Linux
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6 Specifications

Computer specifications

Dimensions
Depth 26.9 cm (10.59 in)
Width 41.2 cm (16.22 in)

Height (front to rear)

3.24 to 3.84 cm (1.28 to 1.51 in)

Weight (lowest weight configuration)

< 3.0 kg (6.61 Ibs)

Input power

Operating voltage

185Vdc@4.74 A-90 W

Operating current

4.74 A

Temperature

Operating (not writing to optical disc)

0°C to 35°C (32°F to 95°F)

Operating (writing to optical disc)

5°C to 35°C (41°F to 95°F)

Nonoperating

-20°C to 60°C (-4°F to 140°F)

Relative humidity

Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)

Operating

-15 m to 3,048 m (-50 ft to 10,000 ft)

Nonoperating

-15 m to 12,192 m (-50 ft to 40,000 ft)

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within

this range of temperatures.

43.9-cm (17.3-in) display specifications

Dimensions

Computer specifications
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Height 23.3cm (9.17 in)
Width 39.8 cm (15.6 in)
Diagonal 43.9 cm (17.3)

Number of colors

Up to 16.8 million

Contrast ratio

300:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch 0.259 x 0.259 mm

Format 1280 x 800; HD: 1600 x 900
Configuration RGB vertical stripe
Backlight LED

Character display 80 x 25

Total power consumption 40W

Viewing angle

+40° horizontal, +120/-40° vertical (typical)
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Hard drive specifications
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640 GB* 500 GB* 320 GB* 250 GB* 160 GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm 70 mm
Weight 1019 1019 1019 1019 101g
Interface type SATA SATA SATA SATA SATA
Transfer rate 106 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ~ ATA security =~ ATA security = ATA security  ATA security
Seek times (typical read, including setting)
Single track 1.0 ms 1.0 ms 1.5 ms 2.0ms 1.5 ms
Average 14.0 ms 14.0 ms 12.0 ms 12.0 ms 11.0 ms
Maximum 24.0 ms 22.0ms 22.0ms 22.0ms 22.0ms
Logical blocks 1,250,26 976,773,168 625,142,448 488,397,168 312,581,808
3,728
Disc rotational speed 5400 rpm 7200 rpm 7200 rpm 7200 rpm 7200 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive

specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.

Hard drive specifications
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DVD*RW and CD-RW SuperMulti Double-Layer Combo
Drive with LightScribe specifications

Applicable disc

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, MIXED
MODE CD, CD-I, CD-I Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD
+RW, DVD-RAM

Write CD-R and CD-RW, DVD+R, DVD+RW, DVD-R, DVD-RW, DVD-RAM

Random access time

DVD <230 ms
CD <175 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec

Transfer mode

Multiword DMA Mode
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Blu-ray ROM with LightScribe DVDR/RW SuperMulti
Double-Layer Drive specifications

ENWW

Applicable disc

Read

BD-ROM, BD-ROM-DL, BD-R, BD-R-DL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVD-R, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and mode 2), CD-ROM XA (mode 2,
form 1 and form 2), Photo CD (single and multiple sessions), CD Extra,
CD-R, CD-RW, and CD-TEXT

Write

DVD-RAM (Ver.2), DVD+R, DVD-R, CD-R, and CD-ROM

Random access time

BD <230 ms
DVD <180 ms
CD <180 ms
Cache buffer 4.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
4X BD 18,000 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec
1X BD-ROM 4,500 KB/sec
1X BD-R read 4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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System resource specifications

Use Device Manager to get a graphical view of the system resources that control how the devices
work on the computer. System resources accessible Device Manager are direct memory access
(DMA) channels, input/output (1/O) ports, interrupt request (IRQ) lines, and memory addresses.

If two devices require the same resource and create a device conflict, manually change the resource
settings in Device Manager to be sure each setting is unique.

/A CAUTION:

Improperly changing resource settings can disable the hardware and cause the

computer to malfunction or become inoperable. Only users who have expert knowledge of computer
hardware and hardware configurations should change resource settings.

To view resource settings in Windows 7 and Windows Vista:

1.

2
3.
4

Select Start > Computer.

Click System properties near the top of the Computer folder.
On the left, click Device Manager.

On the View menu, click one of the following:

e Resources by type

e Resources by connection

To view resource settings in Windows XP:

1.

2
3
4,
5

Select Start > My Computer, or double-click My Computer on the desktop.

Under System Tasks, click View system information.

In the System Properties window, select the Hardware tab.
Click Device Manager.

On the View menu, click one of the following:

e Resources by type

e Resources by connection
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Backup and recovery

Recovery after a system failure is as complete as your most current backup. HP recommends
creating recovery discs immediately after software setup. As you add new software and data files,
continue to back up your system on a regular basis to maintain a reasonably current backup.

Tools provided by the operating system and HP Recovery Manager software are designed to help
you with the following tasks for safeguarding your information and restoring it in case of a system
failure:

e Creating a set of recovery discs (Recovery Manager software feature). Recovery discs are used
to start up (boot) the computer and restore the operating system and software programs to
factory settings in case of system failure or instability.

e  Backing up your information regularly to protect your important system files.

e Creating system restore points (operating system feature). System restore points allow you to
reverse undesirable changes to your computer by restoring the computer to an earlier state.

e Recovering a program or driver (Recovery Manager software feature). This feature helps you
reinstall a program or driver without performing a full system recovery.

e Performing a full system recovery (Recovery Manager software feature). With Recovery
Manager, you can recover the full factory image if you experience system failure or instability.
Recovery Manager works from a dedicated recovery partition (select models only) on the hard
drive or from recovery discs you create.

B NOTE: Computers with a solid-state drive (SSD) might not have a recovery partition. Recovery
discs have been included for computers that do not have a partition. Use these discs to recover
the operating system and software. To check for the presence of a recovery partition, select
Start >right-click Computer > click Manage > click Disk Management. If the partition is
present, an HP Recovery drive is listed in the window.

Windows 7

To protect your information, back up your files and folders. In case of system failure, use the backup
files to restore the computer.

/A CAUTION: In the event of a hard drive failure, you cannot use the computer to access the Disaster

ENWW

Recovery utility. Therefore, HP recommends downloading the Disaster Recovery utility SoftPaq, and
then extract it to a USB flash drive as soon as possible after software setup. For details, see
“Downloading and extracting the Disaster Recovery utility” later in this section.
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Depending on the computer model, you might have one of the following backup and recovery
solutions:

° Roxio BackOnTrack

e HP Recovery Manager

B NOTE: For detailed information, perform a search for these topics in Help and Support.

Creating recovery discs

HP recommends creating recovery discs to be sure that you can restore your system to its original
factory state if you experience serious system failure or instability. Create these discs after setting up
the computer for the first time.

Handle these discs carefully and keep them in a safe place. The software allows the creation of only
one set of recovery discs.

NOTE: Use an optional external optical drive (purchased separately) to create recovery discs, or
purchase recovery discs for the computer from the HP Web site.

Note the following guidelines before creating recovery discs:

B NOTE: The external hard drive must be connected to a USB port on the computer, not to a USB
port on an external device such as a hub.

e  Use high-quality DVD-R, DVD+R, BD-R (writable Blu-ray), or CD-R discs. All these discs are
purchased separately. DVDs and BDs have a much higher capacity than CDs. If you use CDs,
up to 20 discs might be required, whereas only a few DVDs or BDs are required.

B¥ NOTE: Read-write discs, such as CD-RW, DVD+RW, double-layer DVD+RW, and BD-RE
(rewritable Blu-ray) discs, are not compatible with the Recovery Manager software.

e The computer must be connected to AC power during this process.
e  Only one set of recovery discs can be created per computer.
e Number each disc before inserting it into the optical drive.

e If necessary, exit the program before you have finished creating the recovery discs. The next
time you open Recovery Manager, you are prompted to continue the disc creation process.

To create a set of recovery discs:
1. Select Start > All Programs > Recovery Manager > Recovery Disk Creation.

2. Follow the on-screen instructions.

104 Chapter 7 Backup and recovery ENWW



Backing up your information

As you add new software and data files, back up the system on a regular basis to maintain a
reasonably current backup. Back up your system at the following times:

e Atregularly scheduled times

Ef NOTE: Setreminders to back up your information periodically.

e Before the computer is repaired or restored
e  Before you add or modify hardware or software
Note the following when backing up:

e Create system restore points using the Windows System Restore feature, and periodically copy
them to disc.

e  Store personal files in the Documents library and back up this folder periodically.
e  Back up templates stored in their associated programs.

e  Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document steps:
1. Display the screen.
2. Copy the screen:
To copy only the active window, press alt+prt sc.
To copy the entire screen, press prt sc.
3. Open a word-processing document, and then select Edit > Paste.
4. Save the document.
e  Back up the information to an optional external hard drive, a network drive, or discs.

e  When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD-R, or DVD+RW. The discs you use will depend on the type of optical
drive installed in the computer.

B NOTE: DVDs store more information than CDs, so using them for backup reduces the number
of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.
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Using Windows Backup and Restore

To create a backup using Windows Backup and Restore:

B NOTE: Be sure that the computer is connected to AC power before starting the backup process.

NOTE: The backup process might take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up and create a backup.

B NOTE: Windows includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Using system restore points

When backing up the system, you are creating a system restore point. A system restore point allows
you to save and name a snapshot of your hard drive at a specific point in time. You can then recover
back to that point if you want to reverse subsequent changes made to the system.

Br NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created
since the last restore point.

You also can create additional restore points to provide increased protection for the system files and
settings.

When to create restore points

Before you add or extensively modify software or hardware

Periodically, whenever the system is performing optimally

Br NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.

Create a system restore point

1.

2
3
4.
5
6

Select Start > Control Panel > System and Security > System.

In the left pane, click System Protection.

Click the System Protection tab.

Under Protection Settings, select the disk for which you want to create a restore point.
Click Create.

Follow the on-screen instructions.

Restore to a previous date and time

To revert to a restore point (created at a previous date and time), when the computer was functioning

optimally:

1. Select Start > Control Panel > System and Security > System.
2. Inthe left pane, click System protection.

3. Click the System Protection tab.

4. Click System Restore.

5. Follow the on-screen instructions.

Performing a recovery

Br NOTE: You can recover only files that you have previously backed up. HP recommends using
Recovery Manager to create an entire drive backup as soon as you set up the computer.
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Recovery Manager software allows you to repair or restore the system if you experience system
failure or instability. Recovery Manager works from recovery discs or from a dedicated recovery
partition (select models only) on the hard drive. However, if the computer includes a solid-state drive
(SSD), you might not have a recovery partition. If that is the case, recovery discs are included with
the computer. Use these discs to recover the operating system and software.

Windows 7 107



B NOTE: Windows has its own built-in repair features, such as System Restore and driver roll-back
capabilities. Try these features before using Recovery Manager.

NOTE: Recovery Manager recovers only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Website or reinstalled from
the disc provided by the manufacturer.

Recovering from the recovery discs
To restore the system from the recovery discs:
1. Back up all personal files.
2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Recovering from the dedicated recovery partition (select models only)

B NOTE: If the computer includes an SSD, you might not have a recovery partition. You cannot
recover using this procedure. Recovery discs are included for computers that do not have a partition.
Use these discs to recover the operating system and software.

On some models, you can perform a recovery from the partition on the hard drive, accessed by
pressing either the Start button or f11. This restores the computer to its factory condition.

To restore the system from the partition:
1. Access Recovery Manager in either of the following ways:
e  Select Start > All Programs > Recovery Manager > Recovery Manager.
—or—

e Turn on or restart the computer, and then press esc while the “Press the ESC key for
Startup Menu” message is displayed at the bottom of the screen. Then, press 11 while the
“Press <F11> for recovery” message appears

2. Click System Recovery in the Recovery Manager window.

3. Follow the on-screen instructions.
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Linux backup and recovery

Use the instructions in this section if SUSE Linux SLED 11 is installed on the computer.

To protect your information, back up your files and folders. Then if the system fails, restore your
important files from copies. Use the options listed in this section to restore the operating system and
programs that were installed at the factory.

/A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
created and any software installed on the computer are permanently removed. The 11 recovery tool
reinstalls the original operating system and HP programs and drivers that were installed at the
factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal
files must be restored from a backup.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. Restart the computer, and then press f11 while the “Press <F11> for recovery” message
appears on the screen.

3. Follow the on-screen instructions.

Br NOTE: If you are unable to boot (start up) the computer from the primary operating system or from
the recovery f11 method, purchase a SUSE Linux Enterprise Desktop Operating System DVD to
repair the operating system. For additional information, see the Worldwide Telephone Numbers
booklet, included with the computer.
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8 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel
2 Audio out, right channel
3 Ground

ENWW

Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground
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External monitor

@O 006
®000
®00006

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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RJ-11 (modem)

111
123456

Pin Signal

Unused

Tip

Ring

Unused

Unused

o & B B N O S I

Unused

RJ-45 (network)

i
12345678

] —

3
5

Signal

Transmit +

Transmit -

Receive +

Unused

Unused

Receive -

Unused

o0 | N o | o B~ WO|DN| =

Unused
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HDMI

1917151311 9 7 5 3 1

NrATATATAVATATATATASS

1816 141210 8 & 4 &

Pin Signal

1 TMDS data 2+

2 TMDS data 2 shield
3 TMDS data 2—

4 TMDS data 1+

5 TMDS data 1shield
6 TMDS data 1-

7 TMDS data 0+

8 TMDS data 0 shield
9 TMDS data 0—

10 TMDS clock+

11 TMDS clock shield
12 TMDS clock—

13 CEC

14 No connect

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect

20 Shell
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Universal Serial Bus

ENWW

1 2 3 4
I_-_-_-.I

Pin Signal
1 +5VDC
2 Data -
3 Data +
4 Ground
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9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries or regions

The requirements listed below are applicable to all countries or regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by each country or region’s power system.

e  The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries or regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

/A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

B NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury might be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

Q-

Br NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

-
1
T

g
i

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel (3).
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4. Remove the two screws (1) that secure each hinge to the display enclosure and lift up to remove
the display hinge covers (2).

o

T

e,

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

— ——— — ———— —
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7. Turn the display panel assembly upside down and remove all screws that secure the display
panel frame to the display panel.

8. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.

9. Remove the display panel frame (2) from the display panel.

10. Remove the screws (1) that secure the backlight cover to the display panel.

11. Lift the top edge of the backlight cover (2) and swing it outward.

—0

u
o\

12. Remove the backlight cover.

13. Turn the display panel right-side up.
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14. Remove the backlight cables (1) from the clip (2) in the display panel.

15. Turn the display panel upside down.

16. Remove the backlight frame from the display panel.

A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
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17. Remove the backlight from the backlight frame.

18. Disconnect the display cable (1) from the LCD panel.

19. Remove the screws (2) that secure the LCD panel to the display rear panel.
20. Release the LCD panel (3) from the display rear panel.

21. Release the tape (4) that secures the LCD panel to the display rear panel.
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22. Remove the LCD panel.

23. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394 Power Saving 89

A
AC adapter
identifying 15
AC adapter, spare part numbers
29
administrator password 88
antenna
removal 73
antennas 13
applications key, Windows 9
audio, product description 3
audio-in jack, pin assignments
111
audio-out jack, pin assignments
111

B
backing up
customized window, toolbar,
and menu bar settings 105
personal files 105
templates 105
base enclosure, spare part
number 23
battery
removal 42
spare part numbers 22,42
battery bay, identifying 13
battery release latch, identifying
13
battery, identifying 15
bays
battery 13
hard drive 13
BD/DVD+R/RW Super Multi
Double-Layer Combo Drive
removal 46

ENWW

bezel
illustrated 24
spare part number 24, 71
Blu-ray Disc ROM LightScribe with
SuperMulti DVD+R/RW Double-
Layer
spare part number 27, 46
Blu-ray ROM with LightScribe DVD
+R/RW SuperMulti DL Drive
specifications 101
bluetooth module
removal 68
spare part number
boot options 89, 94

23,68

boot order 89, 94
button sound 89
buttons

power 8

TouchPad right/left 6

C
cables, service considerations 36
camera module

removal 72

spare part number 72
camera, product description 2
caps lock light, identifying 7
Card Reader Power Saving 89
changing the language of Setup

Utility 85
chipset, product description 1
compartments

memory module 13
components

additional hardware 15

bottom 13

front 5

left-side 12

right-side 11

top 6

computer feet
locations 41
spare part number 41
Computer Setup
accessing 90
Diagnostics menu 93
File menu 92
navigating and selecting 90
restoring factory settings 91
Security menu 93
System Configuration menu
94
using 90
computer specifications 97
connector pin assignments
audio-in 111
audio-out 111
external monitor 112
HDMI 114
headphone 111
microphone 111
modem 113
monitor 112
network 113
RJ-11 113
RJ-45 113
Universal Serial Bus (USB)
115
connector, power 11
connectors, service
considerations 36
cord, power 15

D
Diagnostics menu 89, 93
Digital Media Slot light,
identifying 12
Digital Media Slot, identifying 12
diskette drive
precautions 36
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display assembly
removal 69
spare part number
display back cover
spare part number 25
display bezel
illustrated 24
spare part number 24, 71
display bracket and hinge
removal 73
spare part number 73
display component recycling 119
display components
illustrated 24
spare part numbers 24
display enclosure
illustrated 24
display hinge kit, spare part
number 25
display inverter
illustrated 24
display panel
illustrated 24
product description 2
removal 73
spare part number 24,73
Display screw kit, spare part
number 25
display specifications 97
displaying system information 86
drives
boot order 89, 94
preventing damage 36
DVD/CD-RW Combo Drive
precautions 36
removal 46
DVD+RW and CD-RW Combo
Drive
precautions 36
removal 46
DVD£RW SuperMulti DL Drive
with LightScribe
spare part numbers 27, 46
DVD+RW SuperMulti Double-
Layer Drive with LightScribe
specifications 100

19, 69

E
electrostatic discharge 37
esc key, identifying 9
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Ethernet, product description 3
exiting Setup Utility 88
external media cards, product
description 3
external monitor port
pin assignments 112
external monitor port, identifying
12

F
f11 108
fan always on 89
fan/heat sink assembly
removal 79
spare part number
feet
locations 41
spare part number 41
File menu 92
fn key, identifying 9
front components 5
full system recovery 103
function keys, identifying 9

20,79

G

graphics, product description 1

grounding equipment and
methods 39

H
hard drive
precautions 36
product description 2
removal 43
spare part numbers 22, 27, 43
specifications 99
hard drive bay, identifying 13
hard drive cover
illustrated 26
removal 44
hard drive hardware kit, spare part
number 28
hard drive self test 89
HDMI 12
HDMI port, pin assignments 114
headphone jack, pin
assignments 111

|
inverter
illustrated 24

J

jacks
RJ-11 (modem) 11
RJ-45 (network 12

K

keyboard
product description 3
removal 54

spare part numbers 19, 54
keys

esc 9

fn 9

function 9

Windows applications 9
Windows logo 9

L
LAN Power Saving 89
language support 89
latch, battery release 13
legacy support, USB 90, 94
light

power 7
lights

caps lock 7

Digital Media Slot 12

webcam 10

wireless 7

M
Main menu 88
mass storage devices, spare part
numbers 27
memory module
product description 2
removal 51
spare part numbers 20, 51
memory module compartment,
identifying 13
memory test 89
microphone
spare part number 25
microphone (internal), identifying
10
microphone jack, pin
assignments 111
microphone, product description
3
mini-card compartment cover
illustrated 26

ENWW



model name 1
modem jack, pin assignments
113
modem module
product description 3
removal 63
spare part number 22,63
modem module cable
removal 77
monitor port, external 12
monitor port, pin assignments
112

N

navigating in Setup Utility 86

network jack, pin assignments
113

(0]

operating system, product
description 4

optical drive

identifying 11
precautions 36
product description 2
removal 46

spare part numbers 22, 27, 46

specifications 100, 101

P
packing guidelines 38
passwords 88, 93
performing a recovery 107
plastic parts 35
Plastics kit
contents 26
spare part number 26
pointing device, product
description 3
ports
external monitor 12
HDMI 12
product description 3
UsB 11,12
power button board
removal 61
spare part number 61
power button, identifying 8
power connector cable
removal 67
spare part number 22, 67

ENWW

power connector, identifying 11
power cord set requirements 117
power cord, identifying 15
power cord, spare part numbers
29
power light, identifying 7
power requirements, product
description 4
power-on password 88
processor

product description 1
removal 83

spare part numbers 20, 83
Processor C6 State 89
product description

audio 3

camera 2

chipset 1

display panel 2

Ethernet 3

external media cards 3
graphics 1

hard drives 2

keyboard 3

memory module 2
microphone 3

modem module 3
operating system 4
optical drives 2

pointing devices 3

ports 3

power requirements 4
processors 1

product name 1

security 4

serviceability 4

wireless 3
product name 1

R

recovering a program or driver
103

recovering from the dedicated
recovery partition 108

recovering from the recovery
discs 108

recovery discs 103, 104

Recovery Manager 103, 107

recovery partition 103

recovery, system 107

removal/replacement
preliminaries 35
procedures 40
restore points 107
restoring default settings 87
RJ-11 (modem) jack, identifying
11
RJ-11 jack, pin assignments 113
RJ-45 (network) jack, identifying
12
RJ-45 jack, pin assignments 113
RTC battery
removal 52
spare part number 20, 52
Rubber Feet Kit, spare part
number 41

S
secondary hard drive self test 89
security cable slot, identifying 11
Security menu 88, 93
security, product description 4
selecting in Setup Utility 86
serial number 17, 40
service considerations 35
serviceability, product
description 4
setup utility
Diagnostics menu 93
File menu 92
navigating and selecting 90
restoring factory settings 91
Security menu 93
System Configuration menu
94
slots
Digital Media 12
memory module 13
security cable 11
solid-state drive (SSD) 103, 107,
108
speaker assembly
removal 60
spare part number 19, 60
speakers, identifying 8
specifications
Blu-ray ROM with LightScribe
DVDxR/RW SuperMulti DL
Drive 101
computer 97
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display 97
DVD +RW SuperMulti Double-
Layer Drive with LightScribe
100

hard drive 99

optical drive 100, 101

system resources 102
starting Setup Utility 85
static-shielding materials 39
stringent security 93
supported discs 104
system board

removal 75

spare part numbers 22,75
System Configuration menu 89,

94

system failure or instability 103
system fan 94
system information 88, 92
system recovery 107
system resources 102
system restore points 103, 107

T
thermal paste, replacement 81,
82

tools required 35
top cover

removal 57

spare part number 19, 57
TouchPad

buttons 6

identifying 6

removal 62
TouchPad button board

spare part number 62
TouchPad zone

identifying 6
transporting guidelines 38

u
Universal Serial Bus (USB) port,
pin assignments 115

USB board

removal 65

spare part number 22, 65
USB legacy support 90, 94
USB ports, identifying 11, 12
using Setup Utility 85
using system restore 107
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Vv
vents, identifying 12, 13
Virtualization Technology 89

w
webcam
identifying 10
webcam light, identifying 10
Webcam module
spare part number 24
Windows applications key,
identifying 9
Windows logo key, identifying 9
wireless antenna
removal 73
spare part number 25
wireless antennas 13
wireless antennas and cables
removal 74
spare part number 74
wireless antennas and cables,
spare part number 74
wireless light 7
wireless, product description 3
wireless/memory module
compartment cover
removal 49, 51, 53
spare part number 49, 51, 53
WLAN module
removal 48
spare part numbers 21, 48
workstation guidelines 38
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